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About This Book

This book contains information about the System Explorer for z/OS product 
and is intended for all users.

To use this book, you should be familiar with your client and host operating 
systems.

For example, you should know how to perform common actions in a window 
environment (such as choosing menu items and resizing windows).

How This Book Is Organized

This book is organized as follows:

Chapter/Appendix Description

Chapter 1, “Features and Benefits” introduces the System Explorer for z/OS 
product

Chapter 2, “Security” explains how security is implemented in the 
System Explorer for z/OS product

Chapter 3, “Running System 
Explorer for z/OS”

explains how to run the System Explorer for 
z/OS product
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Related Documentation

BMC Software products are supported by several types of documentation:

• online and printed books
• online Help
• release notes and other notices

In addition to this book and the Help, you can find useful information in the 
publications that are listed in the following table. As “Online and Printed 
Books” on page ix explains, these publications are available on request from 
BMC Software.

Document Description

Desktop Installation 
Assistant Getting Started

provides information about using the Desktop 
Installation Assistant, including requirements
The Desktop Installation Assistant is an installation 
wizard that is used to install and configure the 
Runtime Component System (RTCS) and 
RTCS-based products for OS/390 and z/OS.

Runtime Component 
System Configuration and 
Administration Guide

provides information about configuring an OS/390 or 
z/OS system for RTCS and configuring RTCS and 
RTCS-based products

Runtime Component 
System Message 
Reference

contains information about messages that are 
generated by RTCS
The Runtime Component System Message 
Reference is a softcopy document only (.chm file). It 
is on the product installation CD.

System Explorer for z/OS 
General Information

• discusses the business challenges that you face 
every day and how the System Explorer for z/OS 
product can help in overcoming these challenges

• lists the features of the System Explorer for z/OS 
product

• illustrates some of the functionality of the System 
Explorer for z/OS product

System Explorer for z/OS 
Help

contains detailed information about how to use the 
System Explorer for z/OS product
You can access Help in the following ways:
• from the Help menu
• by clicking a Help  icon
• by pressing F1
BMC Software, Inc., Confidential and Proprietary Information
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Online and Printed Books

The books that accompany BMC Software products are available in online 
and printed formats. Online books are formatted as Portable Document 
Format (PDF) files. Some online books are also formatted as HTML files.

To Access Online Books

To view any online book that BMC Software offers, visit the Customer 
Support page of the BMC Software Web site at 
http://www.bmc.com/support_home. You can also access PDF books from the 
product compact disc (CD) that accompanies your product.

Use the free Acrobat Reader from Adobe Systems to view, print, or copy 
PDF files. In some cases, installing the Acrobat Reader and downloading the 
online books is an optional part of the product-installation process. For 
information about downloading the free reader from the Web, go to the 
Adobe Systems site at http://www.adobe.com.

To Request Additional Printed Books

BMC Software provides some printed books with your product order. To 
request additional books, go to http://www.bmc.com/support_home.

Release Notes and Other Notices

Printed release notes accompany each BMC Software product. Release notes 
provide current information such as

• updates to the installation instructions
• last-minute product information

In addition, BMC Software sometimes provides updated product information 
between releases (in the form of a flash or a technical bulletin, for example). 
The latest versions of the release notes and other notices are available on the 
Web at http://www.bmc.com/support_home.
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Conventions

This section provides examples of the conventions that are used in this book 
and explains how to read ISPF panel-flow diagrams and syntax statements.

General Conventions

This book uses the following general conventions:

This book uses the following types of special text:

Note: Notes contain important information that you should consider.

Warning! Warnings alert you to situations that could cause problems, such 
as loss of data, if you do not follow instructions carefully.

Tip: Tips contain information that might improve product performance or 
that might make procedures easier to follow.

Item Example

information that you are 
instructed to type

Type SEARCH DB in the designated field.

specific (standard) 
keyboard key names

Press Enter.

GUI elements and menu 
sequences

Choose File => Open.

directories, file names, 
Web addresses, e-mail 
addresses

The BMC Software home page is at www.bmc.com.

code examples, syntax 
statements, system 
messages, screen text

//STEPLIB DD

The table tableName is not available.

emphasized words, new 
terms

The instructions that you give to the software are called 
commands.

variables In this message, the variable fileName represents the 
file that caused the error.
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Syntax Statements

Syntax statements appear in Courier. The following example shows a sample 
syntax statement:

COMMAND KEYWORD1 [KEYWORD2|KEYWORD3] KEYWORD4={YES|NO}
       fileName...

The following table explains conventions for syntax statements and provides 
examples:

Item Example

Items in italic type represent variables that you 
must replace with a name or value. If a variable is 
represented by two or more words, initial capitals 
distinguish the second and subsequent words.

alias

databaseDirectory

Brackets indicate a group of options. You can 
choose at least one of the items in the group, but 
none of them is required. Do not type the brackets 
when you enter the option. A comma means that 
you can choose one or more of the listed options. 
You must use a comma to separate the options if 
you choose more than one option.

[tableName, columnName, field]

[-full, -incremental, -level] (Unix)

Braces enclose a list of required items. You must 
enter at least one of the items. Do not type the 
braces when you enter the item.

{DBDName | tableName}

{-a | -c} (Unix)

A vertical bar means that you can choose only 
one of the listed items. In the example, you would 
choose either commit or cancel.

{commit | cancel}

{-commit | -cancel} (Unix)

An ellipsis indicates that you can repeat the 
previous item or items as many times as 
necessary.

columnName . . .
BMC Software, Inc., Confidential and Proprietary Information
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Chapter 1 Features and Benefits

This chapter introduces the System Explorer for z/OS product.

Features of System Explorer for z/OS  . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-2
Benefits of System Explorer for z/OS  . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-3
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Features of System Explorer for z/OS
Features of System Explorer for z/OS

The System Explorer for z/OS product is a graphical user interface (GUI) 
that provides the ease of the graphical environment for performing many of 
the functions of TSO, ISPF, SDSF and so on.

You can use System Explorer for z/OS to manage data sets and submit jobs 
through a GUI. Here are just a few of the features that come standard with 
System Explorer for z/OS: 

• simplify the management of base z/OS and OS/390 components

• create, browse, and edit data sets by using the built-in editor or your 
editor of choice

• manage job submission and output from a familiar GUI 

• view system topology 

• display the SYSLOG
BMC Software, Inc., Confidential and Proprietary Information
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Benefits of System Explorer for z/OS
Benefits of System Explorer for z/OS

Whether you are familiar or unfamiliar with mainframes, the System 
Explorer for z/OS product has benefits for you.

Familiar With Mainframes?

If you are familiar with using a mainframe, System Explorer for z/OS offers 
fast point-and-click and filtering abilities. You can

• view partitioned data sets, sequential data sets, jobs, system resources, 
and so on, all at once in a single navigation tree

• create custom views to filter the information that is shown in a navigation 
tree (for example, all the data sets and jobs for a particular project)

• display information in multiple, resizable windows, side-by-side, all at 
once, and all from one session

• allocate a data set by using one dialog

• submit jobs with the click of a mouse button

• use your favorite desktop editor to edit data sets and members
BMC Software, Inc., Confidential and Proprietary Information
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Benefits of System Explorer for z/OS
Unfamiliar With Mainframes?

If your area of expertise is Unix or Microsoft Windows, or you are new to the 
mainframe, the System Explorer for z/OS product offers all of the 
functionality of the graphical environment that you know. You can

• view data sets in a tree structure in the same way that you view Unix and 
Windows file systems

• copy, move, and delete data sets with the click of the mouse

• view system resources without knowing their names or locations

• control jobs, including submission, with the click of a mouse button 
instead of typing commands

• access a mainframe system from your Windows Start Menu or a shortcut 
icon on your desktop
BMC Software, Inc., Confidential and Proprietary Information
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Chapter 2 Security

This chapter explains how security is implemented in the System Explorer 
for z/OS product.

Access Security. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-2
Data Set and System Resources Security . . . . . . . . . . . . . . . . . . . . . . . . . 2-2
Job Security. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-3
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Access Security
Access Security

Access to the System Explorer for z/OS product is controlled by your 
existing external security manager (ESM).

When you sign on to System Explorer for z/OS, you are prompted for a user 
ID and password. This is your existing mainframe user ID and password.

If access to System Explorer for z/OS has been authorized, you are granted 
access to the product just like any z/OS product.

Data Set and System Resources Security

In the System Explorer for z/OS product, you can view and manage data sets 
and system resource information.

Your existing ESM controls your access to data sets and system resources. 
System Explorer for z/OS interacts with your ESM to use your existing ESM 
profiles.

If data sets and system resources are not being controlled by an ESM, you 
can view and manage all data sets and system resource information.
BMC Software, Inc., Confidential and Proprietary Information
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Job Security
Job Security

In the System Explorer for z/OS product, you can view and control jobs and 
their related SYSIN, SYSOUT, and logs as follows:

1. If an existing ESM controls your access, System Explorer for z/OS uses 
your existing ESM profiles.

2. System Explorer for z/OS job-management rules (SE rules) can be 
established instead of or in addition to the ESM profiles. If SE rules are 
detected by System Explorer for z/OS, they are used. For information 
about SE rules, see “About SE Rules.”

3. If job SPOOL and SYSOUT are not controlled by an ESM or by SE 
rules, you can access all jobs.

About SE Rules

You can establish the SE rules instead of or in addition to your existing ESM 
profiles.

The SE rules control which jobs can be displayed in the System Explorer for 
z/OS product console. The SE rules affect all the information shown under 

 My Jobs on a navigation tree.

Perform the following tasks to implement SE rules:

You can also refresh SE rules at any time (see “Refreshing SE Rules” on 
page 2-14).

Step Action See

1 Define the SE rules. “Defining SE Rules” on page 2-4

2 Identify the SE rules to your 
ESM.

“Identifying SE Rules to Your 
ESM” on page 2-13

3 Load the SE rules. “Loading SE Rules” on page 2-13
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Job Security
Defining SE Rules

SE rules are defined in a data set member, which are then loaded into the 
Runtime Component System (RTCS) System Registry. You can define SE 
rules in the following ways:

• manually coding the SE rules in a data set member

See the following sections:

— “The RULE Statement” on page 2-5
— “RULE Statement Parameters” on page 2-5
— “Conventions for Coding the SE Rules” on page 2-8
— “How the SE Rules are Evaluated” on page 2-9

• using the supplied conversion utility to convert SDSF GROUP definitions 
to SE rules

See the following sections:

— “About the Conversion Utility” on page 2-11
— “Running the Utility” on page 2-12

Types of SE Rules and Rights

The following types of SE rules are available:

• Ownership grants the right to view a job, view SYSIN and SYSOUT for 
a job, and issue commands against a job.

• View grants the right to view a job and view SYSIN and SYSOUT for 
the job, but do not grant the right to issue commands against a job.
BMC Software, Inc., Confidential and Proprietary Information
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Job Security
The RULE Statement

The format of the RULE statement is as follows:

ruleName RULE STATUS(ENABLED|DISABLED),
ORDER(n),
OWNER_USERID[(ex](idList)[)],
OWNER_GROUPID[(ex](idList)[)],
OWNER_JOBNAME_PREFIX[(ex](prefixList)[)],
OWNER_ACCOUNT_NUMBER[(ex](acctNumList)[)],
VIEW_USERID[(ex](idList)[)],
VIEW_GROUPID[(ex](idList)[)],
VIEW_JOBNAME_PREFIX[(ex](prefixList)[)],
VIEW_ACCOUNT_NUMBER[(ex](acctNumList)[)],
VIEW_JOB_TYPE(jobTypeList),
VIEW_SUBMIT_USERID[(ex](idList)

Note: A bar (|) indicates to use one of the specified values.
Brackets ([ ]) indicate optional syntax.

RULE Statement Parameters

The following table explains the parameters in the RULE statement:. For 
additional information, see “Conventions for Coding the SE Rules” on 
page 2-8 and “Specifying Partial IDs” on page 2-8.

Table 2-1 RULE Statement Parameters  (Part 1 of 4)

Parameter Description Valid Values

ruleName name of the SE rule
The name is used to create the entity 
name for interaction with your ESM 
(see “Defining SE Rules” on 
page 2-4).
This parameter is required.

alphanumeric characters

STATUS current status of the SE rule
An SE rule can be enabled or 
disabled. If an SE rule is enabled, it is 
evaluated for access rights. If an SE 
rule is disabled, it is ignored.
This parameter is required.

ENABLED
DISABLED

ORDER the order in which the SE rule is 
evaluated
The SE rule with a value of 0 is 
evaluated first, a value of 1 is 
evaluated next, and so on.
This parameter is required.

an integer
BMC Software, Inc., Confidential and Proprietary Information
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Job Security
OWNER_USERID list of user IDs
If an owner ID matches one of the 
specified user IDs, ownership rights 
are granted.
Use the ex prefix to denote that the 
parameter is specifying exclusions. If 
an owner ID matches one of the 
specified user IDs, ownership rights 
are denied.

• userID—a specific user ID
• userID*—a partial user ID
• *—any user ID
• USERID—the current user’s 

user ID
• (USERID,length)—the current 

user's user ID minus the 
number of characters specified 
by length

OWNER_GROUPID list of group IDs
If a group ID matches one of the 
specified group IDs, ownership rights 
are granted. 
Use the ex prefix to denote that the 
parameter is specifying exclusions. If a 
group ID matches one of the specified 
group IDs, ownership rights are 
denied.
Note: This parameter requires 
additional processing of the JES job 
queue which can decrease response 
time.

• groupID—a specific group ID
• groupID*—a partial group ID
• GROUPID—the current user's 

group ID

OWNER_JOBNAME_PREFIX list of job name prefixes
If a job's name begins with any of the 
specified prefixes, ownership rights 
are granted. 
Use the ex prefix to denote that the 
parameter is specifying exclusions. If a 
job's name begins with any of the 
specified prefixes, ownership rights 
are denied. 

• prefix—alphanumeric 
characters

• USERID—the current user's 
user ID is used as a prefix 
value

• GROUPID—the current user's 
group ID is used as a prefix 
value

• (USERID,length)—the current 
user's user ID minus the 
number of characters specified 
by length

OWNER_ACCOUNT_NUMBER list of account numbers
If the account number from the JCL 
JOB statement matches a specified 
account number, ownership rights are 
granted. 
Use the ex prefix to denote that the 
parameter is specifying exclusions. If 
the account number from the JCL JOB 
statement matches a specified 
account number, ownership rights are 
denied. 
Note: This parameter requires 
additional processing of the JES job 
queue which can decrease response 
time.

an account number

Table 2-1 RULE Statement Parameters  (Part 2 of 4)

Parameter Description Valid Values
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Job Security
VIEW_USERID list of user IDs
If an owner ID matches one of the 
specified user IDs, viewing rights are 
granted. 
Use the ex prefix to denote that the 
parameter is specifying exclusions. If 
an owner ID matches one of the 
specified user IDs, viewing rights are 
denied. 

• userID—a specific user ID
• userID*—a partial user ID
• *—any user ID
• USERID—the current user's 

user ID
• (USERID,length)—the current 

user's user ID minus the 
number of characters specified 
by length

VIEW_GROUPID list of group IDs
If a group ID matches one of the 
specified group IDs, viewing rights are 
granted. 
Use the ex prefix to denote that the 
parameter is specifying exclusions. If a 
group ID matches one of the specified 
group IDs, viewing rights are denied. 
Note: This parameter requires 
additional processing of the JES job 
queue which can decrease response 
time.

• groupID—a specific group ID
• groupID*—a partial group ID
• GROUPID—the current user's 

group ID

VIEW_JOBNAME_PREFIX list of job name prefixes
If a job's name begins with any of the 
specified prefixes, viewing rights are 
granted. 
Use the ex prefix to denote that the 
parameter is specifying exclusions. If a 
job's name begins with any of the 
specified prefixes, viewing rights are 
denied. 

• prefix—alphanumeric 
characters

• USERID—the current user's 
user ID is used as a prefix 
value

• GROUPID—the current user's 
group ID is used as a prefix 
value

• (USERID,length)—the current 
user's user ID minus the 
number of characters specified 
by length

VIEW_ACCOUNT_NUMBER list of account numbers
If the account number from the JCL 
JOB statement matches a specified 
account number, viewing rights are 
granted.
Use the ex prefix to denote that the 
parameter is specifying exclusions. If 
the account number from the JCL JOB 
statement matches a specified 
account number, viewing rights are 
denied.
Note: This parameter requires 
additional processing of the JES job 
queue, which can decrease response 
time.

a valid account number

Table 2-1 RULE Statement Parameters  (Part 3 of 4)

Parameter Description Valid Values
BMC Software, Inc., Confidential and Proprietary Information

Chapter 2   Security 2-7



Job Security
Conventions for Coding the SE Rules

Use the following conventions when coding the RULE statements:

• Define as many SE rules as you need.
• Include the STATUS and ORDER parameters, which are required.
• Include one or more OWNER or VIEW parameters in each statement.
• Include one or more value for each parameter.
• Separate each parameter with a comma.
• Enclose the parameter values in parentheses.
• Separate the values of each parameter with a comma.

Specifying Partial IDs

• If you specify a partial user ID, that much of a user’s user ID must match 
the parameter’s value to grant or deny rights. For example, if you specify 
(PAY*), user IDs of PAY, PAYONE, and PAYS all match.

• If you specify (USERID,length), only that much of the user’s ID is used 
to evaluate the statement. For example, if you specify (USERID,4) and 
the user’s user ID is PAYROLL, only PAYR is used during the 
evaluation.

VIEW_JOB_TYPE list of job types
If a job’s type matches a specified job 
type, viewing rights are granted.
This parameter is evaluated in 
conjunction with any of the other 
specified VIEW-type parameters. That 
is, it is ANDed to each of the other 
VIEW-type parameters in the SE rule.

• STC—job is a started task
• TSU—job is a user
• BATCH—job is a batch job
• ALL—STC, TSU, or BATCH

VIEW_SUBMIT_USERID list of user IDs
If the user ID that submitted the job 
matches one of the specified user IDs, 
viewing rights are granted. 
Use the ex prefix to denote that the 
parameter is specifying exclusions. If 
the user ID that submitted the job 
matches one of the specified user IDs, 
viewing rights are denied.
Note: This parameter requires 
additional processing of the JES job 
queue which can decrease response 
time.

• userID—a specific user ID
• userID*—a partial user ID
• *—any user ID
• USERID—the current user's 

user ID
• (USERID,length)—the current 

user's user ID minus the 
number of characters specified 
by length

Table 2-1 RULE Statement Parameters  (Part 4 of 4)

Parameter Description Valid Values
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Job Security
How the SE Rules are Evaluated

If SE rules are being used, they are evaluated using the following criteria to 
display information on the console:

• If no SE rules are defined, all users are granted ownership rights to all 
jobs.

• If SE rules are defined and no SE rule applies to a user, the user is denied 
any rights to all jobs.

• If only exclusions are specified, a user is granted ownership rights to all 
jobs that are not specifically excluded.

• SE rules are evaluated in the order specified by the ORDER parameter. A 
value of 0 is evaluated first, a value of 1 is evaluated next, and so on.

• The first SE rule to which you have READ access is evaluated to 
establish your ownership and viewing rights.

If you do not have READ access to any SE rule, access is denied.

Tip: Because of this first-met, first-used order, BMC Software 
recommends ordering the SE rules from the most restrictive to 
the least restrictive. 

• Within each statement, the parameters are evaluated in the following 
order:

1. OWNER-type parameters that specify exclusions
2. other OWNER-type parameters
3. VIEW-type parameters that specify exclusions
4. other VIEW-type parameters

• The first parameter within a statement to be evaluated as true is used 
(with the exception of the VIEW_JOB_TYPE parameter for which all the 
parameters are evaluated). 

• The VIEW_JOB_TYPE parameter further limits the evaluation of the 
other VIEW-type parameters. That is, the parameter is ANDed to each of 
the other VIEW-type parameters during the evaluation.
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Job Security
Examples

The following examples demonstrate the RULE statement. In each case, 
READ permission to the SE rule has been granted by the ESM.

• The following SE rule grants ownership rights to all users for all jobs. 
The SE rule is enabled and it is evaluated first.

ALLJOBS RULE STATUS(ENABLED), ORDER(0), 
OWNER_USERID(*)

• The following SE rule grants ownership rights to users for their own jobs 
and restricts them from viewing jobs that begin with PAY. The SE rule is 
enabled and it is evaluated third.

PAYJOBS RULE STATUS(ENABLED), ORDER(2), 
OWNER_USERID(USERID), VIEW_JOBNAME_PREFIX(EX(PAY))

• The following SE rule grants ownership rights to users for their own jobs 
and viewing rights to users for jobs in the groups to which they belong. 
The SE rule is enabled, and it is evaluated second.

MYJOBS RULE STATUS(ENABLED), ORDER(1), 
OWNER_USERID(USERID), VIEW_GROUP(GROUPID)

• The following SE rule grants ownership rights to users for all jobs except 
jobs that are submitted with the account code of 9999. The SE rule is 
enabled, and it is evaluated fifth.

NOPAYRLL RULE STATUS(ENABLED), ORDER(4), 
OWNER_USERID(*), OWNER_ACCOUNT_NUMBER(EX(9999))
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Job Security
About the Conversion Utility

The conversion utility uses some of the parameters in your existing 
ISFPARMS GROUP statements and creates ownership and view SE rules for 
use by System Explorer for z/OS. Not all ISFPARMS GROUP parameters are 
applicable to System Explorer for z/OS. The conversion utility ignores the 
nonapplicable parameters.

The following table lists the ISFPARMS GROUP parameters that the utility 
converts to RULE statement parameters. If an ISFPARMS GROUP parameter 
is not listed in this table, it is not converted.

ISFPARMS GROUP Parameter
Equivalent RULE Statement 
Parameter

NAME(name) ruleName
Note: If a NAME parameter is not used, a 
ruleName is generated.

CMDAUTH(ALL)
CMDLEV (level 0 and 1)

VIEW_JOB_TYPE(ALL)

CMDAUTH(ALL)
CMDLEV (level 2 or higher)

OWNER_USERID(*)

CMDAUTH(DISPLAY) VIEW_JOB_TYPE(ALL)

CMDAUTH(USERID) OWNER_USERID(USERID)

DADFLT VIEW_JOB_TYPE (ALL)

DSPAUTH(ALL) VIEW_USERID(*)

DSPAUTH(GROUP) VIEW_JOBNAME_PREFIX(GROUPID)

DSPAUTH(USERID) VIEW_JOBNAME_PREFIX(USERID)

ICMD(jobName) OWNER_JOBNAME_PREFIX(prefix)

IDSP(jobName) VIEW_JOBNAME_PREFIX(prefix)

OWNER(USERID) VIEW_USERID(USERID)

PREFIX(USERID) VIEW_JOBNAME_PREFIX(USERID)

PREFIX(GROUP) VIEW_JOBNAME_PREFIX(GROUPID)

XCMD OWNER_JOBNAME_PREFIX(EX(prefix))

XDSP VIEW_JOBNAME_PREFIX(EX(prefix))

XDSPD VIEW_JOBNAME_PREFIX(EX(prefix))

XSTATUS VIEW_JOBNAME_PREFIX(EX(prefix))
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Job Security
Running the Utility

Perform the following steps to run the conversion utility:

Step 1 Create a data set member containing the following JCL:

//CNVTRULE EXEC PGM=OSZEXEC8,
//   PARM=’P=ZSE9RULC,C=BMCPROD’,REGION=0M
//*
//ISFPARM  DD  DISP=SHR,DSN=SDSF.PROD.PARMS(ISFPARM)
//ZSERULE  DD  DISP=SHR,DSN=ZSE.PROD.RULES(RULES)
//SYSPRINT DD  SYSOUT=*

Step 2 Replace the data set name in the ISFPARM DD statement with the name of 
the data set that contains your ISFPARMS.

Step 3 Replace the data set name in the ZSERULE DD statement with the name of 
your data set and an applicable member name to contain the SE rules. 

The data set is used as input to load the SE rules to the RTCS System 
Registry.

Step 4 Run the CNVTRULE job.

Step 5 Make any necessary changes to the created RULE statements in the member 
you specified in the ZSERULE DD statement and save the member.
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Job Security
Identifying SE Rules to Your ESM

Each SE rule that you define is identified as a resource to interact with your 
ESM. 

Setting Permissions

Use the following information to set permissions for an SE rule in your ESM:

• The SAF resource class used for the SE rules is FACILITY.
• The entity name for an SE rule is ZSE.RULE.ruleName.
• To grant access to the SE rules, grant READ access to the resource name.

Loading SE Rules

When you define or modify SE rules, you must load them into the RTCS 
System Registry to make them available to the System Explorer for z/OS 
product. The next time the System Explorer for z/OS server is started, it reads 
the SE rules from the RTCS System Registry (see also “Refreshing SE 
Rules” on page 2-14).

Perform the following steps to load the SE rules:

Step 1 Create a data set member containing the following JCL:

//UPDRULE EXEC PGM=OSZEXEC4,
//   PARM=’P=ZSE9RULU,C=BMCPROD’,REGION=0M
//*
//ZSERULE   DD   DISP=SHR,DSN=ZSE.PROD.RULES(RULES)
//SYSPRINT  DD   SYSOUT=*
//SYSTERM   DD   SYSOUT=*
//STDOUT    DD   SYSOUT=*
//STDERR    DD   SYSOUT=*

Step 2 Replace the data set name in the ZSERULE DD statement with the name of 
your data set and an applicable member name to contain the SE rules. 

Step 3 Run the UPDRULE job. 

The SE rules are now loaded into the RTCS System Registry.
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Refreshing SE Rules

If you make changes or additions to your SE rules, they do not normally take 
effect until the System Explorer for z/OS server is restarted. You can, 
however, manually refresh the SE rules into the System Explorer for z/OS 
server without restarting the server.

Perform the following steps to manually refresh the SE rules:

Step 1 Modify the data set member that contains your SE rules.

Step 2 Add the REFRESH to the parameters in the JCL you created to load the SE 
rules:

//UPDRULE EXEC PGM=OSZEXEC4,
//   PARM=’P=ZSE9RULU,C=BMCPROD,REFRESH’,REGION=0M
//*
//ZSERULE   DD   DISP=SHR,DSN=ZSE.PROD.RULES(RULES)
//SYSPRINT  DD   SYSOUT=*
//SYSTERM   DD   SYSOUT=*
//STDOUT    DD   SYSOUT=*
//STDERR    DD   SYSOUT=*

Step 3 Run the UPDRULE job. 

The SE rules are reloaded into the RTCS System Registry.
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Chapter 3 Running System Explorer 
for z/OS

This chapter explains how to run the System Explorer for z/OS product.

System Explorer for z/OS Components . . . . . . . . . . . . . . . . . . . . . . . . . . 3-2
Running the Server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-2
Installing the Client Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-3
Starting the Console . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-8
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System Explorer for z/OS Components
System Explorer for z/OS Components

The System Explorer for z/OS product consists of the following components:

• a server, which runs on your mainframe
• a client, which runs the System Explorer for z/OS console on your 

desktop computer

Running the Server

This section explains how to install, start, and stop the System Explorer for 
z/OS server.

Installing the Server

The System Explorer for z/OS server is installed and configured when the 
Runtime Component System (RTCS) is installed and configured. For 
information about installation and configuration, see the Desktop Installation 
Assistant Getting Started booklet and the documentation on the product CD.

Starting the Server

Note: Before starting the server, RTCS must be running. (For additional 
information see the Runtime Component System Configuration and 
Administration Guide.)

During the configuration process, you are given the exact command to use to 
start the server. The command is executed at a z/OS or OS/390 command 
prompt. The command takes the following forms:

F ssid,START,ZSE
F ssid,START,ZSE,J=cscb

Variable Meaning

ssid the subsystem ID that you assigned to RTCS (usually this will 
be RTCS)

cscb the CSCB (command scheduling control block) name prefix to 
be used
If you do not specify this value, ZSE is used.
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Installing the Client Files
Stopping the Server

To stop the System Explorer for z/OS server, execute one of the following 
commands at a z/OS or OS/390 command prompt:

Installing the Client Files

This section explains how to install and uninstall the System Explorer for 
z/OS client files.

Requirements

The following software and hardware is required on your desktop computer 
to install the client files and run the System Explorer for z/OS console:

• Microsoft Windows 95 or later (with administrator privileges)

• Java Runtime Environment (JRE) 1.3.1_05 (if needed, it is installed 
during the installation process)

• a TCP/IP network connection to your z/OS or OS/390 systems

• a Web browser
— Internet Explorer 5.0 or later
— Netscape 4.0 or later

• 15 MB of free space on the hard drive on which you are going to install 
System Explorer for z/OS and the JRE

• 128 MB RAM (256 MB recommended)

If You Started the Server Using This Command Use This Command to Stop the Server

F  ssid,START,ZSE P ZSE

F  ssid,START,ZSE,J=cscb P cscb
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Installing the Client Files
Installing the Client Files

Perform the following steps to install the System Explorer for z/OS client 
files:

Step 1 Open a Web browser.

Step 2 Type the following address in your browser’s address or location field and 
press Enter:

http://systemName:port/zse/index.html

The systemName variable is the DNS server name or IP address of the host 
mainframe server. The port variable was specified during the MVS image 
configuration. If you do not have this information, contact your system 
administrator. If you have multiple systemName and port pairs, use any one 
of the pairs. To add additional systems, see “Adding Additional Systems” on 
page 3-6.

The installation applet dialog box is displayed. 

If you do not have a JRE installed or the JRE is version 1.3.1 or later, the 
browser prompts you to install version 1.3.1_05 of the JRE. This version of 
the JRE is shipped with System Explorer for z/OS. If you have a different 
JRE installed, version 1.3.1_05 is installed in addition to your existing 
version. 

Step 3 (optional) To install the JRE, perform the following steps:

3.A Click the Click here for Java 1.3.1_05 Plug-in link.

You are prompted to download the install file or to run it from its 
current location. 

3.B Select either option and click OK.
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Installing the Client Files
3.C If you downloaded the file, execute the file to start the JRE 
installation. Otherwise, the installation starts from its current 
location.

Warning! During the installation, the JRE installation program 
gives you the opportunity to specify that you want the 
JRE to become the default Java engine. Some products 
do not work properly with the Sun Java applet plug-in.

To disable the JRE as the default Java engine, perform one of the 
following tasks:

• During the installation, clear the default Java engine check 
boxes.

• After the installation, open Internet Explorer, choose 
Tools => Internet Options, click the Advanced tab, scroll down to 
the Sun Java section, and clear the check boxes.

3.D When the JRE installation is complete, click the specified link.

The installation applet dialog box is displayed.

Step 4 Click Install Local Client.

The Client Install Wizard is displayed. You can close the installation applet 
dialog box.

Note: If the Java Plug-in Security Warning dialog box is displayed and you 
trust the Java Plug-in, click Grant always.

Step 5 Follow the instructions in the wizard until you come to the Install Complete 
page. To install the client in a directory other than the directory that is 
displayed, perform the following steps:

5.A Click Browse and navigate to an existing directory under which you 
want to install the client.

5.B Click the Create New Folder  icon.

5.C Right-click the new folder, specify a new name, and press Enter.

5.D Double-click the new folder and click Open.

Several files are installed on your desktop computer and registry entries are 
made.
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Installing the Client Files
Step 6 On the Install Complete page, choose whether to launch the console 
immediately:

• To complete the installation and launch the console immediately, select 
Launch System Explorer for z/OS and click Finish.

• To complete the installation without launching the console, clear Launch 
System Explorer for z/OS and click Finish.

Adding Additional Systems

To access different systems, you must run the console with different system 
names and port numbers. To accomplish this task, you must add additional 
systems to the System Explorer for z/OS Start Menu.

Perform the following steps to add each additional system to the Start Menu:

Step 1 On your computer, right-click Start and choose Explore.

The file explorer opens to the location of your program list for the Start 
Programs menu. For example, on Windows 2000, this location is 
C:\WINDOWS\Start Menu.

Step 2 If not already in the Programs directory, open the Programs directory.

Step 3 Navigate to a shortcut for a System Explorer for z/OS console under System 
Advisor (for example, System Explorer on sjse).

Step 4 Copy the shortcut, paste it into the same directory, and rename it.

Step 5 Right-click the renamed shortcut and choose Properties.

The Properties dialog box is displayed.

Step 6 Click the Shortcut tab.

Step 7 In the Target field, change the server parameter to the new system name and 
port number that you want.

Step 8 Click OK.

The new shortcut is added to the System Explorer for z/OS Start Menu.
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Installing the Client Files
Updating the Client Files

Each time you run System Explorer for z/OS, the client files are checked 
against what is stored with the System Explorer for z/OS server to ensure that 
they are current. 

If the client files are current, the client starts. 

If the client files are not current, the installation update wizard is 
automatically started to install the new files. Click the specified button and 
the update starts. When the update is completed, the logon dialog box is 
displayed (for more information, see “Running the Console” on page 3-8). 
You can now close the installation update wizard.

Reinstalling the Client Files

To reinstall the client files, simply uninstall the client files and then install 
them again. 

For uninstallation information, see “Uninstalling Client Files” on page 3-7.

For installation information, see “Installing the Client Files” on page 3-4.

Uninstalling Client Files

To uninstall the System Explorer for z/OS client files, click Start and choose 
Programs => System Advisor => Uninstall.

The System Explorer for z/OS product is removed from your computer, 
including the registry entries.

If you had added additional systems (see “Adding Additional Systems” on 
page 3-6), the directories for the additional systems and the product directory 
are not removed during the uninstall. You must delete them manually.
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Starting the Console
Starting the Console

This section explains how to run the System Explorer for z/OS console and 
how to change your mainframe password by using System Explorer for z/OS.

Running the Console

Perform the following steps to run the System Explorer for z/OS console:

Step 1 Verify that the RTCS and the System Explorer for z/OS servers are running.

Step 2 On your desktop computer, choose Start => Programs => System 
Advisor => System Explorer on systemName.

The logon dialog box is displayed.

Note: Each time you run System Explorer for z/OS, the client files are 
checked to ensure that they are current. If the client files are current, 
the client starts. If they are not current, the installation wizard is 
automatically started to install the new files. For installation 
information, see “Installing the Client Files” on page 3-4.

Step 3 Enter the following information and click OK:

Field What to Enter

User ID your mainframe user ID

Password your mainframe password

GROUP Ident (optional) your group name
BMC Software, Inc., Confidential and Proprietary Information

3-8 System Explorer for z/OS Getting Started



Starting the Console
Step 4 The System Explorer for z/OS console opens.

The following files are created on your computer:

• application_system.properties

This file is created in the directory in which the client files were installed. It 
contains console control information (such as the console size and location 
on your desktop) and the user ID of the last person to log on by using your 
computer.

• userID.ini

This file is created in the Windows Profile directory. It contains preferences 
settings, column sort order, column position, column sizes, and the filter 
information for the default and custom views.

Step 5 After starting the console, use any of the following methods to open the 
online documentation:

• from the Help menu
• by clicking a Help icon 
• by pressing F1

The online documentation provides detailed information about the product.

Changing Your Password

When you run System Explorer for z/OS, you can change your mainframe 
password on the logon dialog box. 

Perform the following steps to change your password:

Step 1 Run the System Explorer for z/OS console. 

The logon dialog box is displayed.

Step 2 In the User ID field, type your user ID.

Step 3 In the Password field, type your existing password.

Step 4 In the New Password field, type a new password.

Step 5 Click OK. 

Your password is changed, and the console opens.
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END USER LICENSE AGREEMENT
NOTICE

BY OPENING THE PACKAGE, INSTALLING, PRESSING “AGREE” OR “YES” OR USING THE PRODUCT, THE ENTITY OR INDIVIDUAL
ENTERING INTO THIS AGREEMENT AGREES TO BE BOUND BY THE FOLLOWING TERMS. IF YOU DO NOT AGREE WITH ANY OF
THESE TERMS, DO NOT INSTALL OR USE THE PRODUCT, PROMPTLY RETURN THE PRODUCT TO BMC OR YOUR BMC RESELLER,
AND IF YOU ACQUIRED THE LICENSE WITHIN 30 DAYS OF THE DATE OF YOUR ORDER CONTACT BMC OR YOUR BMC RESELLER FOR
A REFUND OF LICENSE FEES PAID. IF YOU REJECT THIS AGREEMENT, YOU WILL NOT ACQUIRE ANY LICENSE TO USE THE
PRODUCT.   

This Agreement (“Agreement”) is between the entity or individual entering into this Agreement (“You”) and BMC Software Distribution, Inc., a
Delaware corporation located at 2101 CityWest Blvd., Houston, Texas, 77042, USA or its affiliated local licensing entity (“BMC”). “You” includes you
and your Affiliates. “Affiliate” is defined as an entity which controls, is controlled by or shares common control with a party. IF MORE THAN ONE
LICENSE AGREEMENT COULD APPLY TO THE PRODUCT, THE FOLLOWING ORDER OF LICENSE AGREEMENT PRECEDENCE APPLIES:
(1) WEB BASED LICENSE AGREEMENT WITH BMC, (2) WRITTEN LICENSE AGREEMENT WITH BMC, (3) SHRINK-WRAP LICENSE
AGREEMENT WITH BMC PROVIDED WITH THE PRODUCT, AND (4)THIS ELECTRONIC LICENSE AGREEMENT WITH BMC. In addition to the
restrictions imposed under this Agreement, any other usage restrictions contained in the Product installation instructions or release notes shall
apply to Your use of the Product. 

PRODUCT AND CAPACITY. “Software” means the object code version of the computer programs provided, via delivery or electronic
transmission, to You. Software includes computer files, enhancements, maintenance modifications, upgrades, updates, bug fixes, and error
corrections. 

“Documentation” means all written or graphical material provided by BMC in any medium, including any technical specifications, relating to the
functionality or operation of the Software. 

“Product” means the Software and Documentation. 

“License Capacity” means the licensed capacity for the Software with the pricing and other license defining terms, including capacity restrictions,
such as tier limit, total allowed users, gigabyte limit, quantity of Software, and/or other capacity limitations regarding the Software. For licenses
based on the power of a computer, You agree to use BMC’s current computer classification scheme, which is available at http://www.bmc.com or
can be provided to You upon request. 

ACCEPTANCE. The Product is deemed accepted by You, on the date that You received the Product from BMC.

LICENSE. Subject to the terms of this Agreement, as well as Your payment of applicable fees, BMC grants You a non-exclusive, non-transferable,
perpetual (unless a term license is provided on an order) license for each copy of the Software, up to the License Capacity, to do the following:

(a) install the Software on Your owned or leased hardware located at a facility owned or controlled by You in the country where You acquired the
license; 

(b) operate the Software solely for processing Your own data in Your business operations; and

(c) make one copy of the Software for backup and archival purposes only (collectively a “License”). 

If the Software is designed by BMC to permit you to modify such Software, then you agree to only use such modifications or new software
programs for Your internal purposes or otherwise consistent with the License. BMC grants You a license to use the Documentation solely for Your
internal use in Your operations.

LICENSE UPGRADES. You may expand the scope of the License Capacity only pursuant to a separate agreement with BMC for such expanded
usage and Your payment of applicable fees. There is no additional warranty period or free support period for license upgrades. 

RESTRICTIONS: You agree to NOT: 

(a) disassemble, reverse engineer, decompile or otherwise attempt to derive any Software from executable code; 

(b) distribute or provide the Software to any third party (including without limitation, use in a service bureau, outsourcing environment, or
processing the data of third parties, or for rental, lease, or sublicense); or

(c) provide a third party with the results of any functional evaluation or benchmarking or performance tests, without BMC’s prior written approval,
unless prohibited by local law.

TRIAL LICENSE. If, as part of the ordering process, the Product is provided on a trial basis, then these terms apply: (i) this license consists solely
of a non-exclusive, non-transferable evaluation license to operate the Software for the period of time specified from BMC or, if not specified, a 30
day time period (“Trial Period”) only for evaluating whether You desire to acquire a capacity-based license to the Product for a fee; and (ii) Your
use of the Product is on an AS IS basis without any warranty, and BMC, ITS AFFILIATES AND RESELLERS, AND LICENSORS DISCLAIM ANY
AND ALL WARRANTIES (INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NON-INFRINGEMENT) AND HAVE NO LIABILITY WHATSOEVER RESULTING FROM THE USE OF THIS
PRODUCT UNDER THIS TRIAL LICENSE (“Trial License”). BMC may terminate for its convenience a Trial License upon notice to You. When
the Trial Period ends, Your right to use this Product automatically expires.   If You want to continue Your use of the Product beyond the Trial Period,
contact BMC to acquire a capacity-based license to the Product for a fee. 

TERMINATION. This Agreement shall immediately terminate if You breach any of its terms. Upon termination, for any reason, You must uninstall
the Software, and either certify the destruction of the Product or return it to BMC. 



OWNERSHIP OF THE PRODUCT. BMC or its Affiliates or licensors retain all right, title and interest to and in the BMC Product and all intellectual
property, informational, industrial property and proprietary rights therein. BMC neither grants nor otherwise transfers any rights of ownership in the
BMC Product to You. Products are protected by applicable copyright, trade secret, and industrial and intellectual property laws. BMC reserves any
rights not expressly granted to You herein.

CONFIDENTIAL AND PROPRIETARY INFORMATION. The Products are and contain valuable confidential information of BMC (“Confidential
Information”). Confidential Information means non-public technical and non-technical information relating to the Products and Support, including,
without limitation, trade secret and proprietary information, and the structure and organization of the Software. You may not disclose the
Confidential Information to third parties. You agree to use all reasonable efforts to prevent the unauthorized use, copying, publication or
dissemination of the Product.

WARRANTY. Except for a Trial License, BMC warrants that the Software will perform in substantial accordance with the Documentation for a
period of one year from the date of the order. This warranty shall not apply to any problems caused by software or hardware not supplied by BMC
or to any misuse of the Software.

EXCLUSIVE REMEDY. BMC’s entire liability, and Your exclusive remedy, for any defect in the Software during the warranty period or breach of the
warranty above shall be limited to the following: BMC shall use reasonable efforts to remedy defects covered by the warranty or replace the
defective Software within a reasonable period of time, or if BMC cannot remedy or replace such defective copy of the Software, then BMC shall
refund the amount paid by You for the License for that Software. BMC's obligations in this section are conditioned upon Your providing BMC prompt
access to the affected Software and full cooperation in resolving the claim. 

DISCLAIMER. EXCEPT FOR THE EXPRESS WARRANTIES ABOVE, THE PRODUCT IS PROVIDED “AS IS.” BMC, ITS AFFILIATES AND
LICENSORS SPECIFICALLY DISCLAIM ALL OTHER WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND NON-INFRINGEMENT. BMC DOES NOT WARRANT THAT THE
OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR FREE, OR THAT ALL DEFECTS CAN BE CORRECTED.

DISCLAIMER OF DAMAGES. IN NO EVENT IS BMC, ITS AFFILIATES OR LICENSORS LIABLE FOR ANY SPECIAL, INDIRECT,
INCIDENTAL, PUNITIVE OR CONSEQUENTIAL DAMAGES RELATING TO OR ARISING OUT OF THIS AGREEMENT, SUPPORT, AND/OR
THE PRODUCT (INCLUDING, WITHOUT LIMITATION, LOST PROFITS, LOST COMPUTER USAGE TIME, AND DAMAGE OR LOSS OF USE
OF DATA), EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, AND IRRESPECTIVE OF ANY NEGLIGENCE OF BMC OR
WHETHER SUCH DAMAGES RESULT FROM A CLAIM ARISING UNDER TORT OR CONTRACT LAW. 

LIMITS ON LIABILITY. BMC’S AGGREGATE LIABILITY FOR DAMAGES IS LIMITED TO THE AMOUNT PAID BY YOU FOR THE LICENSE TO
THE PRODUCT.

SUPPORT. If Your order includes support for the Software, then BMC agrees to provide support (24 hours a day/7 days a week) (“Support”). You
will be automatically re-enrolled in Support on an annual basis unless BMC receives notice of termination from You as provided below. There is a
free support period during the one year warranty period. 

(a) Support Terms. BMC agrees to make commercially reasonable efforts to provide the following Support: (i) For malfunctions of supported
versions of the Software, BMC provides bug fixes, patches or workarounds in order to cause that copy of the Software to operate in substantial
conformity with its then-current operating specifications; and (ii) BMC provides new releases or versions, so long as such new releases or versions
are furnished by BMC to all other enrolled Support customers without additional charge. BMC may refuse to provide Support for any versions or
releases of the Software other than the most recent version or release of such Software made available by BMC. Either party may terminate Your
enrollment in Support upon providing notice to the other at least 30 days prior to the next applicable Support anniversary date. If You re-enroll in
Support, BMC may charge You a reinstatement fee of 1.5 times what You would have paid if You were enrolled in Support during that time period. 

 (b) Fees. The annual fee for Support is 20% of the Software’s list price less the applicable discount or a flat capacity based annual fee. BMC may
change its prices for the Software and/or Support upon at least 30 days notice prior to Your support anniversary date. 

VERIFICATION. If requested by BMC, You agree to deliver to BMC periodic written reports, whether generated manually or electronically, detailing
Your use of the Software in accordance with this Agreement, including, without limitation, the License Capacity. BMC may, at its expense, perform
an audit, at your facilities, of Your use of the Software to confirm Your compliance with the Agreement. If an audit reveals that You have underpaid
fees, You agree to pay such underpaid fees. If the underpaid fees exceed 5% of the fees paid, then You agree to also pay BMC’s reasonable costs
of conducting the audit. 

EXPORT CONTROLS. You agree not to import, export, re-export, or transfer, directly or indirectly, any part of the Product or any underlying
information or technology except in full compliance with all United States, foreign and other applicable laws and regulations.    

GOVERNING LAW. This Agreement is governed by the substantive laws in force, without regard to conflict of laws principles: (a) in the State of
New York, if you acquired the License in the United States, Puerto Rico, or any country in Central or South America; (b) in the Province of Ontario,
if you acquired the License in Canada (subsections (a) and (b) collectively referred to as the “Americas Region”); (c) in Singapore, if you acquired
the License in Japan, South Korea, Peoples Republic of China, Special Administrative Region of Hong Kong, Republic of China, Philippines,
Indonesia, Malaysia, Singapore, India, Australia, New Zealand, or Thailand (collectively, “Asia Pacific Region”); or (d) in the Netherlands, if you
acquired the License in any other country not described above. The United Nations Convention on Contracts for the International Sale of Goods is
specifically disclaimed in its entirety.

ARBITRATION. ANY DISPUTE BETWEEN YOU AND BMC ARISING OUT OF THIS AGREEMENT OR THE BREACH OR ALLEGED BREACH,
SHALL BE DETERMINED BY BINDING ARBITRATION CONDUCTED IN ENGLISH. IF THE DISPUTE IS INITIATED IN THE AMERICAS
REGION, THE ARBITRATION SHALL BE HELD IN NEW YORK, U.S.A., UNDER THE CURRENT COMMERCIAL OR INTERNATIONAL, AS
APPLICABLE, RULES OF THE AMERICAN ARBITRATION ASSOCIATION. IF THE DISPUTE IS INITIATED IN A COUNTRY IN THE ASIA
PACIFIC REGION, THE ARBITRATION SHALL BE HELD IN SINGAPORE, SINGAPORE UNDER THE CURRENT UNCITRAL ARBITRATION
RULES. IF THE DISPUTE IS INITIATED IN A COUNTRY OUTSIDE OF THE AMERICAS REGION OR ASIA PACIFIC REGION, THE
ARBITRATION SHALL BE HELD IN AMSTERDAM, NETHERLANDS UNDER THE CURRENT UNCITRAL ARBITRATION RULES. THE
COSTS OF THE ARBITRATION SHALL BE BORNE EQUALLY PENDING THE ARBITRATOR’S AWARD. THE AWARD RENDERED SHALL
BE FINAL AND BINDING UPON THE PARTIES AND SHALL NOT BE SUBJECT TO APPEAL TO ANY COURT, AND MAY BE ENFORCED IN
ANY COURT OF COMPETENT JURISDICTION. NOTHING IN THIS AGREEMENT SHALL BE DEEMED AS PREVENTING EITHER PARTY
FROM SEEKING INJUNCTIVE RELIEF FROM ANY COURT HAVING JURISDICTION OVER THE PARTIES AND THE SUBJECT MATTER OF



THE DISPUTE AS NECESSARY TO PROTECT EITHER PARTY’S CONFIDENTIAL INFORMATION, OWNERSHIP, OR ANY OTHER
PROPRIETARY RIGHTS. ALL ARBITRATION PROCEEDINGS SHALL BE CONDUCTED IN CONFIDENCE, AND THE PARTY PREVAILING IN
ARBITRATION SHALL BE ENTITLED TO RECOVER ITS REASONABLE ATTORNEYS’ FEES AND NECESSARY COSTS INCURRED
RELATED THERETO FROM THE OTHER PARTY. 

U.S. GOVERNMENT RESTRICTED RIGHTS. The Software under this Agreement is “commercial computer software” as that term is described in
48 C.F.R. 252.227-7014(a)(1). If acquired by or on behalf of a civilian agency, the U.S. Government acquires this commercial computer software
and/or commercial computer software documentation subject to the terms of this Agreement as specified in 48 C.F.R. 12.212 (Computer Software)
and 12.211 (Technical Data) of the Federal Acquisition Regulations (“FAR”) and its successors. If acquired by or on behalf of any agency within
the Department of Defense (“DOD”), the U.S. Government acquires this commercial computer software and/or commercial computer software
documentation subject to the terms of this Agreement as specified in 48 C.F.R. 227.7202 of the DOD FAR Supplement and its successors.

MISCELLANEOUS TERMS. You agree to pay BMC all amounts owed no later than 30 days from the date of the applicable invoice, unless
otherwise provided on the order for the License to the Products. You will pay, or reimburse BMC, for taxes of any kind, including sales, use, duty,
tariffs, customs, withholding, property, value-added (VAT), and other similar federal, state or local taxes (other than taxes based on BMC’s net
income) imposed in connection with the Product and/or the Support. This Agreement constitutes the entire agreement between You and BMC and
supersedes any prior or contemporaneous negotiations or agreements, whether oral, written or displayed electronically, concerning the Product
and related subject matter. No modification or waiver of any provision hereof will be effective unless made in a writing signed by both BMC and You.
You may not assign or transfer this Agreement or a License to a third party without BMC’s prior written consent. Should any provision of this
Agreement be invalid or unenforceable, the remainder of the provisions will remain in effect. The parties have agreed that this Agreement and the
documents related thereto be drawn up in the English language. Les parties exigent que la présente convention ainsi que les documents qui s’y
rattachent soient rédigés en anglais.
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